Analytic Element Modeling of Groundwater Flow, H. M. Haitjema, Academic Press, 1995, 0080499104, 9780080499109, 394 pages. Modeling has become an essential tool for the groundwater hydrologist. Where field data is limited, the analytic element method (AEM) is rapidly becoming the modeling method of choice, especially given the availability of affordable modeling software. Analytic Element Modeling of Groundwater Flow provides all the basics necessary to approach AEM successfully, including a presentation of fundamental concepts and a thorough introduction to Dupuit-Forchheimer flow. This book is unique in its emphasis on the actual use of analytic element models. Real-world examples complement material presented in the text. An educational version of the analytic element program GFLOW is included to allow the reader to reproduce the various solutions to groundwater flow problems discussed in the text. Researchers and graduate students in groundwater hydrology, geology, and engineering will find this book an indispensable resource.* * Provides a fundamental introduction to the use of the analytic element method.* Offers a step-by-step approach to groundwater flow modeling.* Includes an educational version of the GFLOW modeling software.

DOWNLOAD HERE


A mathematical primer on groundwater flow an introduction to the mathematical and physical concepts of saturated flow in the subsurface, John F. Hermance, 1999, Science, 230 pages. Preparing users for further study in numerical modeling, this practical, succinct review of the mathematical foundations of groundwater flow connects various mathematical flow ....


Introduction to Groundwater Modeling Finite Difference and Finite Element Methods, Herbert F. Wang, Mary P. Anderson, Jul 26, 1995, Technology & Engineering, 237 pages. The dramatic advances in the efficiency of digital computers during the past decade have provided hydrologists with a powerful tool for numerical modeling of groundwater ....

Analytical groundwater modeling flow and contaminant migration, William Clarence Walton, 1989, Science, 173 pages. This new book includes four analytical microcomputer programs - on two diskettes-for quick easy simulation and graphing of uncomplicated two-dimensional groundwater flow and...

Groundwater Science, Charles R. Fitts, Nov 5, 2012, Science, 692 pages. Groundwater Science, 2E, covers groundwater's role in the hydrologic cycle and in water supply, contamination, and construction issues. It is a valuable resource for students....

Modeling has become an essential tool for the groundwater hydrologist. Where field data is limited, the analytic element method (AEM) is rapidly becoming the modeling method of choice, especially given the availability of affordable modeling software. Analytic Element Modeling of Groundwater Flow provides all the basics necessary to approach AEM successfully, including a presentation of fundamental concepts and a thorough introduction to Dupuit-Forchheimer flow. This book is unique in its emphasis on the actual use of analytic element models. Real-world examples complement material presented in the text.

An educational version of the analytic element program GFLOW is included to allow the reader to reproduce the various solutions to groundwater flow problems discussed in the text. Researchers and graduate students in groundwater hydrology, geology, and engineering will find this book an indispensable resource.

"Analytic Element Modeling of Groundwater Flow offers much more than one might anticipate from its title. It is an excellent tutorial on the subjects of groundwater flow and modeling groundwater with the analytic element method. I greatly enjoyed reading it, and I recommend it to any student of groundwater hydrology, as well as to researchers and professionals concerned with modeling regional groundwater flow in productive aquifers."

"This book provides a comprehensive introduction to analytic element modeling, emphasizing the actual use of such models.... It is well written and instructional, with later chapters building upon concepts presented in earlier chapters.... The author effectively utilizes ancillary tools to complement the text. These include numerous figures (both hand-drawn and computer generated) and thought-provoking exercises.... The book and accompanying software are excellent resources for researchers, practicing professionals, and graduate students involved in ground water modeling."

This is an excellent introduction and tutorial for the analytic element method. The book works through basic concepts in an easy readable manner without over simplification. The method is introduced and developed in a logical fashion. The discussions are involved enough for use as an ongoing reference. The included demo GFLOW however superseded by the free demo available on the web. Every hydrogeologist should be able to understand and use the method in their toolbox, and this is a very usefull text.

This new method avoids the discretization of a groundwater flow domain by grids or element networks. Instead, only the surface water features in the domain are discretized, broken up in sections, and entered into the model as input data. Each of these stream sections or lake sections are represented by closed form analytic solutions: the analytic elements. The comprehensive solution to a complex, regional groundwater flow problem is obtained by superposition of all, a few hundred, analytic elements in the model.

Traditionally, superposition of analytic functions was considered to be limited to homogeneous aquifers of constant transmissivity. However, by formulating the groundwater flow problem in terms of appropriately chosen discharge potentials, rather than piezometric heads, the analytic element method becomes applicable to both confined and unconfined flow conditions as well as to heterogeneous aquifers (Strack and Haitjema, 1981b).

The analytic elements are chosen to best represent certain hydrologic features. For instance, stream sections and lake boundaries are represented by line sinks, small lakes or wetlands may be represented by areal sink distributions. Areal recharge is modeled by areal source distributions (areal sinks with a negative strength). Streams and lakes that are not fully connected to the aquifer are modeled by line sinks or area sinks with a bottom resistance. Discontinuities in aquifer thickness or hydraulic conductivity are modeled by use of line doublets (double layers). Specialized analytic elements may be used for special features, such as drains, cracks, slurry walls, etc. Locally three-dimensional solutions may be added, such as a partially penetrating well (Haitjema, 1985).

WhAEM is a single aquifer Dupuit-Forchheimer model based on the analytic element method (AEM). The theoretical foundations of this method are found in the text "Groundwater Mechanics" by O.D.L. Strack (1989, Prentice Hall) and in the text "Analytic Element Modeling of Groundwater Flow" by H.M. Haitjema (1995, Academic Press). Additional readings are found in the peer reviewed literature since 1981 and on various web sites by AEM researchers. Also, See FAQ question 1.

After installing a newer version of WhAEM you can read your current (old) database files (*.whm). As soon as the new version accesses an old database file you will get a message that the database must be modified. When confirming (clicking yes) the database will automatically be modified to the format necessary for the newer version. However, once modified, you cannot access that file anymore with the old version of WhAEM.

WhAEM is a database program. This means that data management does not occur in RAM to be saved to disk by an explicit user action (clicking on Save), but any data modifications in WhAEM are immediately implemented in a database, which resides on the disk. This is similar to the way the database program Access or the financial management program Quicken works. Consequently, WhAEM has no Save option, but you will find a Make Duplicate Database option on the Project menu. If you want to make changes in a model and not lose the current model, you must make a duplicate database under a new name before you make your modifications. The database on disk is also referred to as the project file and has the extension .whm. The graphical user interface (GUI) uses various additional files to communicate with the Solver. For each project (file) you should also define a unique Base Filename, which is done on the Project Settings dialog box (Project>Project Settings).

After entering a set of base map files (vector or raster) on the project menu, two post stamp size maps occur on two sides of the map window in WhAEM (after a zoom to extent). This is most likely due to the fact that the base map files represent maps in two different UTM zones. To fix this, project the maps from one of the two zones into the other zone or project both sets of maps into state plane coordinates. This may be done by use of the Reproject Basemaps option on the Tools menu or using GIS software.

Areal recharge is defined as the net amount of water (precipitation minus runoff and minus evapotranspiration) that enters the aquifer per unit time and per unit area. In WhAEM the units are in meters per day or feet per day. The recharge rate may vary over the model domain. You should think in terms of a background recharge rate, applied over the entire model area, and local
adjustments to it. After the near-field and far-field line-sinks have been entered you will have a good idea of the extent of the model area. Place a big (e.g. rectangular) inhomogeneity over the entire model area with the background recharge rate and the (effective) porosity as the only input parameters. The porosity will default to the one specified on the Aquifer tab (Models>Settings>Aquifer). You can use four big line elements to define the area. Make sure you include all line-sinks (you cannot make the area too large). Next, add or subtract recharge in areas where you want a different recharge rate. You do this by defining inhomogeneity domains with the recharge set to what you want to add or subtract.

This may depend on where the surface water feature occurs. In the near-field line-sinks should be placed along the perimeter of the surface water feature, whether a lake or a stream. In the farfield streams and small lakes or wetlands may be represented with line-sinks at their centers, while larger lakes and wetlands may still require a few line-sinks around their perimeter. The idea for the near-field lakes or wetlands is that groundwater will enter the lake (wetland) near its boundary, thus that is where the line-sinks should be. In the event that the lake, wetland or stream bottom offers resistance to groundwater inflow or outflow, line-sinks with resistance should be used. As a rule of thumb, the line-sink width should be set to the square root out of the product of the aquifer transmissivity and the bottom resistance. In case this width is more than the stream width, the line-sink may be placed at the center of the stream and be given the actual stream width. These guidelines are also contained in the WhAEM Help system, press F1 when the Linesink String Properties dialog is open and then click on the link "Creating Linesinks in the Near field and Far field."

The area of interest in your model must be surrounded by surface water features (line-sinks) that define the "far-field" hydrology in the model. These line-sinks on the perimeter of your model area perform a similar function as the conditions specified on the perimeter of a finite difference grid. Line-sinks in the far-field receive water or infiltrate water based on arbitrary conditions outside the model domain. Consequently, these line-sinks do not realistically represent surface water and groundwater interactions and should not be given a bottom resistance, width and depth parameter. Instead, they should simply maintain the specified head, regardless of the amount of water that must be extracted or infiltrated. By checking the box "Treat as"far-field" on the linesink dialog box all fields, except for the heads, are disabled. In summary, all line-sinks on the outside of the model domain must be checked as "Treat as "far-field". For further reading on the matter see "Analytic Element Modeling of Groundwater Flow" by H. M. Haitjema, Academic Press, 1995, Section 5.1.1 page 207.

While WhAEM is a so-called Dupuit-Forchheimer model, which uses two-dimensional flow equations, the third (vertical) component of flow can be estimated from continuity considerations. In case the aquifer has a constant transmissivity and a constant recharge rate the vertical component of flow in WhAEM appears to be the same as found from a truly three-dimensional model. In all other cases the vertical component of flow in WhAEM is approximate. For most cases of regional flow the approximation is very accurate. For further reading on the matter see "Analytic Element Modeling of Groundwater Flow" by H. M. Haitjema, Academic Press, 1995, Section 3.5 (page 140).

Since WhAEM traces pathlines in three-dimensions, a Starting Elevation must be defined for each pathline trace. It is recommended that for capture zone delineation you set the Starting Elevation equal to the aquifer bottom. In this manner the pathline trace will remain along the aquifer bottom, providing for the largest capture zone. Higher Starting Elevations may result in shorter pathlines as a (hypothetical) water particle is back traced in time to the point where it entered the aquifer at the water table (or aquifer top). Remember that in a Dupuit-Forchheimer model, like WhAEM, partially penetrating wells are treated as fully penetrating. Consequently, you can define a Starting Elevation at the aquifer bottom even though in reality the well screen may not reach that deep.

WhAEM uses a numerical integration process, which is part of the GFLOW1 Solver, for tracing pathlines. The step size is fixed and defined as a percentage (2%) of the horizontal size of the window setting in WhAEM. Consequently, for a large window (zoomed out) the step size is large and the pathline trace may be inaccurate. This is often evident from the hooky nature of the trace near
the well. There are two remedies: (a) zoom in to the area where you expect the capture zone to occur or (b) select a smaller step size on the Model>Settings>Tracing tab. The small window option is the most reliable. If you need to have a larger window, you may first trace in a zoomed in window and after the capture zone is complete zoom out to the desired window. This will maintain tracing accuracy (unless you do a new trace, of course).

WhAEM is a steady state model. Capture zone delineation is usually performed with a steady state model, since time dependent capture zones would be of little regulatory value. If aquifers respond fast to transient forcing (pumping periods), it is best to specify the maximum pumping rates (when the wells are running). However, if the aquifer responds slowly to the pumping periods, it may be more reasonable to specify average pumping rates. Similarly, test point values should be used for conditions of maximum pumping or averages may be more appropriate. The issue of fast or slow responding aquifers is addressed quantitatively in "Analytic Element Modeling of Groundwater Flow" by H.M. Haitjema (1995, Academic Press, section 5.3.7).

When calibrating to heads the distribution of the heads may be more meaningful than a root mean square error (RMSE). Look for about as many heads that are too high as that are too low. You do not want to see trends in the errors (all high heads in one area) and one should only look for errors in the near field (area of interest). What errors in the head can be accepted? Quite frankly, that is not easily answered since we are not modeling to predict heads! The modeling objective, in the context of source water assessment, is to predict the capture zone for one or more wells. Strictly speaking, therefore, you should calibrate against observed capture zones, but those don’t exist (this is why you are modeling in the first place). On the other hand, a good match of the heads (whatever that means) does not in any way guarantee a good capture zone. For instance, the aquifer porosity has no effect on your steady state solution in terms of heads or flows. However, the length of the "time of travel" capture zone will depend greatly on the aquifer porosity.

3) These "bounding solutions" will yield some bounding ratios of aquifer recharge over aquifer conductivity. Within this range of recharge/conductivity ratios determine the most likely upper bound and lower bound for the recharge rate and the conductivity itself. You may look at baseflow in streams in the model area to get a feel for the recharge rates, which in turn will yield the conductivities based on the modeling results: recharge /conductivity ratios.

5) Now you will know if the errors are acceptable. If the capture zones are not too different, or if the differences in capture zones are inconsequential (e.g. all avoid an industrial area) your model accuracy is "acceptable." If the spread in capture zones is of concern you know that you need more reliable data (better stream elevations, recharge rates and conductivity values).

analytic element method approximation aquifer bottom aquifer thickness aquifer top areal recharge average boundary conditions calculated capture zone channel deposits circular complex potential comprehensive potential coniferous aquifer contaminant continuity of flow Darcy’s law data identified depicted in Figure differential equation discharge potential discharge vector domain drawdowns Dupuit-Forchheimer equipotential far field identified identified data figure flow flow conditions Forchheimer ft/day GFLOW1 grid groundwater flow modeling Haitjema homogeneous aquifer hydraulic conductivity infiltration infinite inhomogeneities landflow Laplace’s equation line doublet line sink lower aquifer MODFLOW obtained outwash parameters partially penetrating permeable piezometric contours piezometric head point sink pond Program recharge rate satisfies Section sink disc slurry wall specific discharge stagnation point Strack stream function streamlines surface water three-dimensional Tippecanoe River transient two-dimensional unconfined flow uniform flow upper aquifer values variations velocity vertical Wabash River water divide water level water table WHPA zero

http://kgarch.org/cnd.pdf
http://kgarch.org/3b.pdf
http://kgarch.org/cee.pdf
http://kgarch.org/98l.pdf
http://kgarch.org/eeh.pdf
http://kgarch.org/cd.pdf